II.C Access 1

Create and Query a Simple Database
PRIVATE 

Purpose

This lab includes 4 sections: The first section shows you how to create a database. The second section is how to modify the database. In the third section, you will query the database using filtering and setting query criteria. The last section is how to create reports from query results, and how to compact the database. 

By the end of this lab, you will accomplish the following tasks:

Section 1: Create a database

· Create a table of records in Design view. 

· Define table structure.

· Set a primary key.

· Add records to a table in Datasheet view.

· Save a table.

· Create a form with AutoForm.

· Navigate records.

· Save and exit the database.
Section 2: Modify the database

· Use the find feature to locate a record.

· Use the replace feature.

· Update records in Datasheet and Design views. 

· Add and delete a record.

· Add and delete a field.

· Sort table records.

· Set field properties – Format and Input Mask.

Section 3: Query the database 

· Filter records by selection and form.

· Set query criteria.

· Run a query.

· Save query results.

Section 4: Create reports

· Use the report wizard.

· Save a report.

· Compact the database. 

This lab can be done in one long lab setting, or it can be divided into short labs where each section can be conducted separately.

To have sufficient disk space, it is recommended that you use a blank floppy disk for saving the database that will be created in this lab.  The disk including the saved database should be available in each section of the lab.

II.C Access - Section 1: Create a database

Procedure
1. Click the Start menu locate Microsoft Access. Point to it and click to open. Access window will appear as shown in Figure 1. Select Blank Database. 
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Figure 1: Creating a blank database

2. Name the database Univeristy.mdb and choose a location to store it. Hint, a database size grows rapidly, depending on the activities during interaction with the database (modification, using queries, creating new objects, etc). To avoid getting your floppy disk full, store the database first on the hard drive and then copy it to the floppy disk after closing Access. 
3. Creating a database table 

Select Tables object then double-click on Create table in Design view as in Figure 3:
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Figure 3: Creating a table in Design view


The table’s Design view window will appear as shown in Figure 4.
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Figure 4: Table in design view

4. Defining table structure 

In this step, you will define the structure of records used in the database table. As in Figure 4, each field contains Filed Name, Data type, Description, and Filed Properties. The table structure you will use is as follows:

	Field Name
	Data Type
	Description
	Field Size

	Student ID
	Number
	
	Integer

	Name
	Text
	First and Last
	30

	Major
	Text
	
	14

	Year
	Text
	Your school year
	12

	Phone
	Text
	In the form (000) 000-0000
	24

	City
	Text
	
	16

	State
	Text
	
	16

	Zip
	Number
	
	Integer


a) Enter all fields with data type, description, and field properties to the table in Design view as shown in Figure 5. 
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Figure 5: Defining table structure in Design View

b) Make Student ID the Primary Key field. To do this, click in the Student ID row, then click the primary key button from the toolbar, or right-click in the Student ID row then select the primary key option. 
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5. Save the table structure under the name Students. Simply click on the disk icon in the main toolbar, or select [File | Save]. 


The Save As dialog box will appear as shown in Figure 6. Click OK to save.
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Figure 6: Saving a table
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6. Adding table records in Datasheet view 

After saving the table, you can go on and edit records in the table’s 
Datasheet view. To view the table in this way, click on the view button 

in the upper left-hand corner, or select Datasheet View from the View menu.

Enter the six records shown in Figure 7 then save the table.
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Figure 7: Table in Datasheet view


Just as the fields were entered in the Design view, they now make up the columns of the Datasheet view, with data for each individual field listed below each heading.

7. Creating a Form with AutoForm 
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The Form view of a table allows you to scroll through each record and view its fields, each one in a separate entry box. To automatically create a form from a table, use AutoForm, and do the following:
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Click the New Object: AutoForm button, or select 

AutoForm from the list of options in the down-arrow, next to the button.

Figure 8: Selecting AutoForm

b) The form will appear as shown in Figure 9.
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Figure 9: Form view 

8. Save the form by clicking the save button [image: image8.png]Microsoft Access BETES




. It will be saved under the Form object with the same name as the table (Students).

[image: image9.png]Form e
Concel





Figure 10: Saving a form 

9. Navigating records 
Now, the form can be navigated for easy and quick access to all of a record’s data that was entered in the table’s fields.  Below is a basic guide to navigate records in a Form view.
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Figure 11: Navigating records in a Form view


Try navigating all records to become more familiar with the Form view.

10. Saving the database and closing Access 
 

a) Close the form and table windows, then do the following:
Click the [image: image11.png]


 button at the upper right corner of the form and table windows, or click the form [image: image12.png]53 Students



 or table [image: image13.png]Students : Table



 buttons at the upper left corner of the window, then select Close. 

b)
In the database window, click the Tables button that is under the Objects heading. You should see a listing of Students table under the options for creating a table. Capture the screen showing this listing and paste it in word.

c)
In the database window, click the Forms button that is under the Objects heading. You should see a listing of Students form under the existing options for creating a form. Capture the screen showing the listing and paste it in the same word document. 

a) From the File menu, select Exit to close the database. 

Note that another way to close the database is to click the [image: image14.png]


 button at the upper right corner of Access’s window.
b) Include your name on top of the Word document. The two captured screens should look similar to Figure 12. Note that you might need to resize the captured images so that they fit in one page. 

· Print the Word document and refer to item 1 in the activity sheet at the end of this lab.
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Figure 12: Captured windows showing contents of Table and Form objects

II.C Access - Section 2: Modify the database

Procedure

1. Open the existing database Univeristy.mdb by selecting the option Open a file. See Figure 13. If the database is not listed in the dialog box, click the [More Files] option and look for the database where it is stored.
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Figure 13: Opening an existing database

a) In the database window, double-click the Students table to open it. It should look similar to Figure 14.
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Figure 14: Students table of records

b) In the database window, double-click the Students form to open it. It should look similar to Figure 15.
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Figure 15: Students Form
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Locating records with the Find feature
To find a particular word, name, number, or something else that may be found in some record you are searching for, click the Find button. 

The Find and Replace dialog box will appear similar to Figure 16.

In the Students form, look for a record that includes the word Kelly and set the Match to Any Part of Field. 
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Figure 16: The Find and Replace dialog box

To do this, type Kelly in the Find What: box located in the Find tab, then click the Find Next button. 

The Find and Replace box will remain open, but behind it, in the table or form, the data that was searched for will be accessed and highlighted if it exists. See Figure 17.
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Figure 17: Record with Kelly word found

By clicking the Find Next button, additional entries that match what was searched for will be shown in the order in which they are found.

3. Using the Replace feature

If it is desired, one may search for something in a database and simultaneously replace the entry with some other specific entry.  

Apply the following to the Students table:

Select the Replace tab after clicking the Find button [image: image21.png]L=18] ]
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. 

In the [Find What:] box, type Norman Fenster to search for, and 

In the [Replace With:] box, type your name to replace Norman Fenster with your name.  Click the Replace button.
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Figure 18: Replacing the name in 1st record with your name

Click the Cancel button to return to the table. 

The name in the first record of the table will be replaced with your name, as shown in Figure 19.  Save the table.
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Figure 19: Modified table – First record includes your name

Tip:
Another way to modify a record would be to directly replace the existing data in a record field with new data. Simply click in any field and overwrite the data, then save the table. 

4. Updating records in Datasheet and Form views

Since the table was modified in the previous step, the changes would be reflected in the form automatically. 

To verify the automatic change in the form, do the following:

Switch to the form window to make it active then go to the first record.

You should see your name in the name box as shown in Figure 20.
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Figure 20: Changes reflected in Form view

5. Add and delete a record

In this step, you will practice adding and deleting records by entering data directly in the table.  

a) Switch to the table in Datasheet view and add the following new record:

First, place the cursor in the blank row, under the last record of the table, or click the new record [image: image25.png]


 button, and then start typing data that belong to each field.
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Another way to add a record is to right-click on the record index then select New Record.


Student ID: 206

Phone: (412) 367-1243


Name: Jack Zimmer 

City: Pittsburgh


Major: Social Work

State: PA


Year: Senior


Zip: 15237

The table with the new record added should look similar to Figure 21.
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Figure 21: A new record added to the table

b) Delete the record with Student ID = 205, Dawn Zambeck.  


To do this, right-click on the index of their record. 


Select Delete Record. 


If prompted with the confirmation dialog box, click Yes to delete the record.
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The modified table will look similar to Figure 22.

Save the table. To view changes reflected in the form, close the form then re-open it.
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Figure 22: Table updated with a new record added and an existing record deleted

6. Add and delete a field

Adding a new field may be done in Design or Datasheet views. 

To add a field in Design view, switch the table to design view then add the new field before or after an existing row. To add a field in Datasheet view, click a column header located on the right side of the new field location. 

In this section, you will add a new field called Street to the table in Datasheet view.

Do the following:
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a) Add a new field called Street to the table in Datasheet view and place it to the left of the City field. The default data type for the Street field will be Text. 

To do this, right-click on the City field then select Insert Column. The new column will be inserted to the left of City. The heading of the new column is called Field1.  

Rename Field1 to Street by clicking on Field1 then selecting Rename Column. The table will look similar to Figure 23.
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Figure 23: New field added to the table in Datasheet view

c) Enter the following addresses under the new field for each record, and then save the table:

1234 Borland Street

1275 Willow Drive

1000 Montour Drive

3111 Fine Street

62 Orange Lane 

5 Georgia Lane

The table with the new addresses will look similar to Figure 24 below.
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Figure 24: Addresses added for each record under the new field

Note that to delete a field, right-click on the field heading then select Delete Column. The existing field will be deleted permanently. 

7. Sorting table records

To sort a table by one of its fields, right-click on the field, which is the heading of a column, and select weather to sort descending or ascending. The entire table will be sorted according to this selection.  

a) 
Sort the table in descending order and by Student ID. See Figure 25.
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Figure 25: Sorting table records by Student ID field in descending order
· Refer to item 2 in the activity sheet at the end of this lab and print the Students table sorted in descending order.

b) 
Sort the table this time in ascending order and by Student ID, then Save the table.


It should go back to its original order, as it was in Figure 24 because the default sorting is by first field. 
8. Setting field properties

In this step, you will set Format property to the State field so that it will force characters in this field to display in capital letters. You will also set Input Mask property to the Phone field to control the style of the phone number.

Do the following:

a)
Switch the table view to Design view, then click anywhere in the State row and enter the greater sign > in the Format property within the lower sub-window of the Design view. This will restrict letters in the State field to be capitalized.

b)
Click anywhere in the Phone row and set the Input Mask property to the form:


(000) 000-AAAA. The first six digits will be restricted to numbers, whereas the remaining four digits will be either numbers or characters. Figure 26 illustrates these properties.

c) 
Save the table and switch to Datasheet view.
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Figure 26: Setting Field Properties

II.C Access - Section 3: Query the database

Procedure

In this section you will query the database using filtering by selection or form, and by imposing a query with a certain criteria and run it to obtain query results. 

1. Filtering records by Selection


It retrieves temporarily all records that match the selected field.


Example:
Retrieve all records from the Students table where the city is Pittsburgh?


To do this, click any cell of the City column where the city is Pittsburgh then either 


click the Filter by Selection button or right-click and choose Filter by Selection.


You may also select Filter by Selection from the [Records| Filter] menu.


The table will appear with records that match the City=Pittsburgh.  See Figure 27.
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Figure 27: Records filtered by selection where City=Pittsburgh

To get back to the original table, click the Remove Filter button. [image: image34.png]VM»
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2. Filtering records by Form


Filtering by form is used when more than one criteria is needed for filtering. 

Example: Filter all records that have the Major = Education or Year = Senior?
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To do this, click the Filter by Form [image: image35.png]


 button, or right-click and choose Filter by Form.


The datasheet of the Students table will appear blank where you specify criteria from the drop-down menu in the selected field (s). 

Set the following criteria:

· Click the Look for tab at the bottom left side corner of the Datasheet window then select Education from the Major field. 

· Click the Or tab then click in the Year field and select Senior. See Figure 28.

· Click the Apply Filter button [image: image36.png]
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Figure 28: Setting Filter by Form criteria – Major=Education or Year=Senior

The table with matching records will appear similar to Figure 29
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Figure 29 Records filtered by form where Major=Education or Year=Senior 

Remove the filter to get back to the original table.

Tip: You can add as many “Or” tabs as you want, so that a less specific filter will be given to the table or form, and a less stringent set of criteria make for more matching records. 

3. Query the database with a single table 

In this step, you will query the system with the existing table Students, which has been used in this lab thus far. The query type is Select, which is similar to filtering.

Select Query Criteria

Example 1: 


Find the names of all students who are history major and graduating this year?


This is equivalent to:  Get all records where Major=History AND Year=Senior.

To do this, you should run a query object then set the criteria. 
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Specifically, do the following:

a) In the University database window, click the Queries object then double-click on the option Create query in Design view. 
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b) The Show Table dialog box will appear listing the available objects of tables and queries. Click the Tables tab and select the Students table. Add the table to the query by clicking the Add button, and then close the dialog box. 

c) The fields of the Students table will appear in the query window.

Select each field and double-click to add it to the query. See Figure 30.

d) 
Each field in the query includes a show box. 

If you don’t wish to include a field in a query result, just turn off the show box mark. 

[image: image39.png](T TR (TR (3 rare sttt EET—
(Gters —[Sugerts[suirks Sty ety [l [zt [sudns
2] 7] 7] 2] s}





Figure 30: Adding table fields to the query and Setting Criteria

e)
Omit the State and Zip fields in the query result by clicking/turning off their show boxes.

f)
Set the criteria Major=History by typing History in the Criteria row and under the Major column.  Repeat the same for Year=Senior. 


Tip: Since both criteria are set within the same criteria row, they will be interpreted as AND operator.  To use an OR operator, set part of the criteria in the Or row.


g)
To view the SQL code, which is the database language that Access uses behind the seen, click the View button under the File menu and select SQL View. 


Access will convert the query criteria to an SQL code


as follows:

SELECT Students.[Student ID], Students.Name, Students.Major, Students.Year, Students.Phone, Students.Street, Students.City

FROM Students

WHERE (((Students.Major)="History") AND ((Students.Year)="Senior"));

4. Running a Query 

Once table fields are added to a query and criteria are set, you can run the query.

Run the query by clicking the Run button [image: image40.png]


, or by choosing Run from the Query menu. The query result should look similar to Figure 31. Click the Save icon to save the query.


Tip: To get back to the query, select Design view from the View button. 


To view the query result again without running the query, select Datasheet view from the View button.

Note: The fields that were checked off in the query did not appear in the query result.
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Figure 31: Query result

Tips: 

1. Saving the query or its result refers to the same object, and switching between query views can be done using the View selection button. 

2. To append a query to an existing or a new database, right-click anywhere on the query in Design view and select Query Type.

Example 2:  

Set the following criteria and run the query again:

Find the names of all students who are education or psychology major?


Get all records where Major=Education OR Major=Psychology
Omit the State and Zip fields in the query result.

Sort the query result by the Major field and in ascending order. 
Save the result. It should look similar to Figure 32.

[image: image42.png]Queryl : Select Query

* i
Record: 14 T o (o1 [p#] of 4

Student ID_| Name Major Year | Phone | City. I
204 Janet Willardson Education  Freshmen  (412)524-7890 _ Pitsburgh
| 201 Jay Kelly Education  Junior (4122271618 Gibsonia
| 203 Carla Mitchel Psychology  Sophomore | (4123789032 Aliquippa
200 Your name goes here  Psychology  Freshmen  (412)375-1345  Pittsburgh




Figure 32: Select Query result with OR operator 

·  Refer to Item 3 in the activity sheet at the end of this lab and print a copy of the query result by selecting Print from the File menu.

5. Query the database with multiple tables

In this step, you will add two more tables to the database, then you will query the system with three tables: the previous table Students and the two that will be created in this step. 

Do the following:

a) Create a table called Courses, which includes the structure below, and make Course ID the Primary Key, then save the table.

	Field Name
	Data Type
	Field Size

	Course ID
	Text
	50

	Course name
	Text
	50

	Description
	Text
	50



Enter the records shown in Figure 33.
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Figure 33: Course table

b) 
Create a table called Grades, which includes the structure below, then save the table.

	Field Name
	Data Type
	Filed Size

	Student ID
	Number
	Integer

	Course ID
	Text
	50

	Term
	Text
	50

	Grade
	Text
	50 



Allow duplicate entries by setting the Indexed field property to Yes as shown in Figure 34.
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Figure 34: Allowing duplicate entries in Grades table


Enter the records shown in Figure 35:
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Figure 35: Grades table

c) 
Start a query object and add the three tables to the query.

The links (Joins) between common fields in the tables will appear automatically in the query window because they have the same name and the same data type. 

See Figure 36. 
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Figure 36: Adding fields of three tables and setting criteria

d) 
Add the following fields to the query: 

	Student ID
	Name
	Course ID
	Course name
	Grade
	Term


e) Set the following criteria and run the query.
Criteria:
Find all students who took the course CS131?

This is equivalent to:

Retrieve all records where Table: Courses-Course ID=C4

   AND Table: Grades-Course ID=C4 


AND Table: Students–Student ID= Table: Grades-Student ID

The SQL code is:
SELECT Students.[Student ID], Students.Name, Grades.[Course ID], Courses.[Course name], 


Grades.Grade, Grades.Term

FROM (Courses INNER JOIN Grades ON Courses.[Course ID] = Grades.[Course ID]) INNER JOIN Students ON Grades.[Student ID] = Students.[Student ID]

WHERE (((Grades.[Course ID])="C4"));

f) Run the query. The result should look similar to Figure 37. 
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Figure 36: Multiple tables - Query result 

· Refer to item 4 in the activity sheet at the end of this lab and print the query result.
IIC Access - Section 4: Create Reports

Procedure

In this section, you will create two reports. One report is for the Students table, and the other is for the multiple-table query result. 

1.
Click the Reports object in the database window, and double-click Create report by using Wizard option.
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Figure 38: Create a report by using Wizard option

2.
Select the Students table and add all available fields to the Selected Fields sub-window, except for State and Zip, then walk through the wizard. 
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Figure 39: Creating a report for a table

3. Choose a layout and style of your own for the report. 

For example: the report shown in Figure 40 uses Tabular layout and corporate style.

Save the report under the default name Students.
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Figure 40: Report for the Students table without State and Zip fields

4. Repeat steps 1 to 3 and create a report for the query result.

Include all fields of the query result in the following order:

Student ID

Name

Course ID 

Course name 

Grade 

Term


Choose a layout and style for this report. 


For example, the report shown in Figure 41 uses a justified layout and bold style.

Name the report University Database and include your name, then save it.
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Figure 41: Report of the multiple-table query result

· Preview and print the report of the multiple-table query result refer to item 5 in the activity sheet at the end of this lab. The printout refers to Figure 41.   

5. Compacting the database

Compacting a database reduces its size significantly, especially when the database is very large. 

To compact the open database, click on the Tools menu, point to Database Utilities, and select Compact and Repair Database…. 
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Figure 42: Starting to compact the database

The database will be compacted and all open tables or forms will be closed. The database is still open, however, and any of its tables, forms, queries, or reports can be reopened easily by double-clicking them in the Database window.

[image: image53.png]Forms

et abe m Desn v
Creae tate by sig wezrd
e tabe by enterng dota

Grates
sudents




Figure 43: Database objects

Close all objects in the database and Exit Access.

Lab 5
Create and Query a Simple Database
(II.C Access-1: Sections 1 – 4)

Activity Sheet
Name _____________________________________


     

Score = _______




     






Total = 40 points

Email____________________________________




Directions:  Place this sheet on top of the completed document and staple them. Number any printed documents with the activity number listed below.

1) Print a copy of the Word document showing two captured windows, which include the contents of Table and Form objects, with your name on top of the document. (4)

The printout should look similar to Figure 12.

2) Print a copy of the Students table showing records sorted in descending order. (10)

The printout should look similar to Figure 25.

3) Print a copy of the single-table query result showing all student names in Education or Psychology majors. Refer to Figure 32. (6)

4) Print a copy of the multiple-table query result that showing all students who took CS131. Refer to Figure 37. (10)

5) Print the report of the multiple-table query including the title and your name. 

Refer to Figure 41. (10)
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